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Question Number : 1 Question Id : 2549896430 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT an example of an application software?

Options :

1.  MS-Word

2.  Screen saver program

3.  Operating system

4.  Antivirus program

   

Question Number : 1 Question Id : 2549896430 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏनिलिखत मƶ से कौन सा एËलीकेशन सॉÌटवेयर का एक उदाहरण नहƭ है?

Options :

1.  MS-Word

2.  ×þीन सेवर ĒोĀाम



3.  ऑपरिेटंग िस×टम

4.  एटंीवायरस ĒोĀाम

   

Question Number : 2 Question Id : 2549896447 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

If a computer is switched on but does NOT respond to a system reset, what is it said to be?

Options :

1.  Dead

2.  Off

3.  Hang

4.  Insensitive

   

Question Number : 2 Question Id : 2549896447 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

यिद कोई कंËयटूर ऑन है लेिकन िस×टम िरसेट पर कोई Ēितिþया नहƭ दे रहा है, तो यह िकस ि×थित मƶ है?

Options :

1.  डेड

2.  ऑफ

3.  हƹग

4.  इंसƶिसिटव

   

Question Number : 3 Question Id : 2549897551 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is meant by a compiler?

Options :

1.  It translates source code to object code.

2.  It is a low level language.

3.  It is an assembly language.

4.  It translates object code to assembly language.

   

Question Number : 3 Question Id : 2549897551 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कंपाइलर ·या करता है?

Options :

1.  यह सोसµ कोड को ऑÍजे·ट कोड मƶ अनूिदत करता है।

2.  यह एक िनÏन ×तरीय भाषा है।

3.  यह एक असƶबली भाषा है।

4.  यह ऑÍजे·ट कोड को असƶबली भाषा मƶ अनूिदत करता है।

   

Question Number : 4 Question Id : 2549898418 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Excel मƶ, कौन सा फं·शन सबसे छोटा मान देता है िजसके िलए संचयी िǼपद िवतरण एक मापदंड मान से कम या बराबर है?

Options :



1.  BINOMINV फं·शन

2.  BINOM.INV फं·शन

3.  INVBINOM फं·शन

4.  INV.BINOM फं·शन

   

Question Number : 4 Question Id : 2549898418 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which function returns the smallest value for which the cumulative binomial distribution is greater 

than or equal to a criterion value in Excel?

Options :

1.  BINOMINV function

2.  BINOM.INV function

3.  INVBINOM function

4.  INV.BINOM function

   

Question Number : 5 Question Id : 2549899320 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Keyboard keys like Caps Lock that turn a feature on or off are called:

Options :

1.  combination keys

2.  toggle keys

3.  function keys



4.  special purpose keys

   

Question Number : 5 Question Id : 2549899320 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िकसी bीचर को चालू या बंद करने वाली Caps Lock जैसी की-बोडµ की_ ·या कहलाती हƹ?

Options :

1.  कॉिÏबनेशन की_

2.  टॉगल की_

3.  फं·शन की_

4.  ×पशेल पपµ_ की_

   

Question Number : 6 Question Id : 25498912044 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The function of an assembler is to convert:

Options :

1.  basic language into machine language

2.  high level language into machine language

3.  assembly language into machine language

4.  assembly language into high level language

   

Question Number : 6 Question Id : 25498912044 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

असƶबलर का काम ______ पिरवितंत करना है।

Options :

1.  बेिसक भाषा को मशीनी भाषा मƶ

2.  उ¼च ×तरीय भाषा को मशीनी भाषा मƶ

3.  असƶबली भाषा को मशीनी भाषा मƶ

4.  असƶबली भाषा को उ¼च ×तरीय भाषा मƶ

   

Question Number : 7 Question Id : 25498920674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is a Jacquard loom?

Options :

1.  A bird found in Japan

2.  A weaving machine using punched cards

3.  The first computer controlled loom

4.  A machine for writing math tables

   

Question Number : 7 Question Id : 25498920674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जैकवडµ लूम (Jacquard Loom) से ·या आशय है?

Options :

1.  जापान मƶ पाया जाने वाला एक प³ी

2. 



 एक बुनाई मशीन िजसमƶ पंच काडµ का इ×तेमाल िकया जाता था

3.  कंËयटूर Ǽारा िनयंिčत पहला लूम

4.  पहा`े िलखने वाली एक मशीन

   

Question Number : 8 Question Id : 25498929735 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ को, िवȁुत ƞप से ĒोĀाम िकया जाता है और िमटाया जाता है। इसे लगभग दस ह_ार बार िमटाया और ĒोĀाम िकया जा 
सकता है।

Options :

1.  मा×·ड ROM

2.  PROM

3.  EPROM

4.  EEPROM

   

Question Number : 8 Question Id : 25498929735 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The ______ is programmed and erased electrically. It can be erased and reprogrammed about ten 

thousand times.

Options :

1.  masked ROM

2.  PROM

3.  EPROM

4. 



 EEPROM

   

Question Number : 9 Question Id : 25498929896 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏन मƶ से कौन सा एक ऐसा बारकोड bॉÊट है िजसमƶ ब`ी माčा मƶ टे·×ट और डेटा को संपीिडत ƞप मƶ संĀिहत िकया जाता है, 
िजसका उपयोग एयरलाइन के बोिडगं पास मƶ भी िकया जाता है?

Options :

1.  PDF417

2.  मै·सीकोड

3.  डेटा मैिĈ·स

4.  कोडबार (Codabar)

   

Question Number : 9 Question Id : 25498929896 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following barcode fonts stores large amounts of text and data in a compressed form 

that is also used by airlines on boarding passes?

Options :

1.  PDF417

2.  MaxiCode

3.  Data Matrix

4.  Codabar

   

Question Number : 10 Question Id : 25498929978 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is a video conferencing software?

Options :

1.  Google Meet

2.  Google Docs

3.  Google Map

4.  Google Pay

   

Question Number : 10 Question Id : 25498929978 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏनिलिखत मƶ से कौन सा एक वीिडयो कॉÊēƶ िसगं सॉÌटवेयर है?

Options :

1.  Goggle Meet

2.  Google Docs

3.  Google Map

4.  Google Pay

   

Question Number : 11 Question Id : 25498931270 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

मदरबोडµ पर ऐ·सीलेरेटेड Āािफ·स पोटµ (AGP) ए·सपƶसन ×लॉट ______ बस पर चलता है।

Options :



1.  16-िबट

2.  32-िबट

3.  64-िबट

4.  128-िबट

   

Question Number : 11 Question Id : 25498931270 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Accelerated Graphics Port (AGP) expansion slot on the motherboard runs on a ______ bus.

Options :

1.  16-bit

2.  32-bit

3.  64-bit

4.  128-bit

   

Question Number : 12 Question Id : 25498931334 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the Hexadecimal equivalent of (100)10?

Options :

1.  160

2.  256

3.  64

4.  16



   

Question Number : 12 Question Id : 25498931334 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

(100)10 का हे·साडेिसमल समतुÒय ·या है?

Options :

1.  160

2.  256

3.  64

4.  16

   

Question Number : 13 Question Id : 25498933058 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following keyboards is designed in the likeness of old-fashioned type writer?

Options :

1.  Qwerty keyboards 

2.  Numeric keypads   

3.  Ergonomic keyboards

4.  Magic keyboards

   

Question Number : 13 Question Id : 25498933058 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏनिलिखत मƶ से कौन सा कीबोडµ पुराने जमाने के टाइप राइटर की तरह बनाया गया है?



Options :

1.  ·वटेɥ कीबोडµ

2.  Êयमेूिरक कीपैड

3.  एगǃनोिमक कीबोडµ

4.  मैिजक कीबोडµ

   

Question Number : 14 Question Id : 25498933186 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In the ______, seven digit binary numbers (between 0 to 127) are used to represent specific 

characters.

Options :

1.  ASCII character set

2.  Binary Coded Decimal

3.  Gray Code

4.  Decimal Code

   

Question Number : 14 Question Id : 25498933186 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

________ मƶ, िविशȌ वणǄ को दशाµने के िलए सात अकंǂ की बाइनरी सं̧ या (0 से 127 के बीच) का उपयोग िकया जाता है।

Options :

1.  ASCII कैरे·टर सेट

2.  बाइनरी कोडेड डेसीमल



3.  Āे कोड

4.  डेसीमल कोड

   

Question Number : 15 Question Id : 25498933944 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ allows screen positions to be selected with the touch of a finger.

Options :

1.  Touch panel

2.  Keyboard

3.  Light Pen

4.  Mouse

   

Question Number : 15 Question Id : 25498933944 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ एक उंगली से टच करके ×þीन पोजीशन चुनने की सुिवधा देता है।

Options :

1.  टच पैनल

2.  कीबोडµ

3.  लाइट पेन

4.  माउस

   

Question Number : 16 Question Id : 2549898791 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a component of LAN?

Options :

1.  Tube

2.  NIC

3.  Switch

4.  UTP

   

Question Number : 16 Question Id : 2549898791 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏन मƶ से कौन सा LAN का एक घटक नहƭ है?

Options :

1.  ǭूब

2.  NIC

3.  ि×वच

4.  UTP

   

Question Number : 17 Question Id : 2549899478 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a characteristic of impact printers?

Options :



1.  Very noisy

2.  Very high consumable costs

3.  Useful for bulk printing due to low cost

4.  There is physical contact with the paper to produce an image

   

Question Number : 17 Question Id : 2549899478 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏन मƶ से ·या इÏपै·ट िĒंटरǂ की एक िवशेषता नहƭ है?

Options :

1.  ये बƓत शोर करते हƹ

2.  इनकी उपभो¹य लागत बƓत अिधक होती है

3.  इनके Ǽारा िĒिंटंग की लागत बƓत कम आती है इसिलए अिधक सं¸या मƶ िĒिंटंग के िलए इनका उपयोग िकया जाता है

4.  इनके Ǽारा छपाई के िलए पेपर को हाथ से पक`ना प`ता है

   

Question Number : 18 Question Id : 2549899492 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

If you want to set the number of copies to be printed in MS-Word, then which of the following is 

the correct option?

Options :

1.  File->Print->in 'copies' option, enter number of copies

2.  File->Print->Properties->Quality->select number of copies option, enter number of copies

3.  File->Print->Properties->Page setup->select number of copies option, enter number of copies



4.  File->Print->Properties->Page setup->select output size option

   

Question Number : 18 Question Id : 2549899492 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word मƶ, यिद आप िĒंट करने के िलए Ēितयǂ की सं¸या सेट करना चाहते हƹ, तो उसके þमǂ से संबंिधत सही िवकÒप कौन सा 
है?

Options :

1.  फाइल -> िĒंट -> 'कॉपी_' िवकÒप मƶ Ēितयǂ की सं̧ या ĒिवȌ करƶ

2.  फाइल -> िĒंट -> Ēॉपटɥज -> ·वािलटी -> 'Ēितयǂ की सं¸या' िवकÒप को चनुƶ, Ēितयǂ की सं¸या ĒिवȌ करƶ

3.  फाइल -> िĒंट -> Ēॉपटɥज -> पेज सेटअप -> 'Ēितयǂ की सं̧ या िवकÒप' चुनƶ, Ēितयǂ की सं̧ या ĒिवȌ करƶ

4.  फाइल -> िĒंट -> Ēॉपटɥज -> पेज सेटअप -> 'आउटपुट साइ_' िवकÒप चुनƶ

   

Question Number : 19 Question Id : 2549899599 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

With reference to printers, PJL stands for:

Options :

1.  Portable Job Language

2.  Portable Job Library

3.  Printer Job Library

4.  Printer Job Language

   

Question Number : 19 Question Id : 2549899599 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 



: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िĒंटरǂ के संदभµ मƶ PJL का पूणµƞप ·या है?

Options :

1.  Portable Job Language (पोटƷबल जॉब लƹ¹वेज)

2.  Portable Job Library (पोटƷबल जॉब लाइĔेरी)

3.  Printer Job Library (िĒंटर जॉब लाइĔेरी)

4.  Printer Job Language (िĒंटर जॉब लƹ¹वेज)

   

Question Number : 20 Question Id : 2549899627 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a printer manufacturing company?

Options :

1.  Epson

2.  Canon

3.  Nippon Electric

4.  Tindle

   

Question Number : 20 Question Id : 2549899627 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏनिलिखत मƶ से कौन सी कंपनी िĒटंर नहƭ बनाती है?

Options :

1.  एËसन (Epson)



2.  कैनन (Canon)

3.  िनपॉन इलिे·Ĉक (Nippon Electric)

4.  िटंडल (Tindle)

   

Question Number : 21 Question Id : 25498911108 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

वायरलेस नेटवकǄ के िलए IEEE मानक िनÏन मƶ से कौन सा है?

Options :

1.  801.12

2.  801.22

3.  802.11

4.  802.13

   

Question Number : 21 Question Id : 25498911108 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is the IEEE standard for wireless networks?

Options :

1.  801.12

2.  801.22

3.  802.11

4.  802.13

   



Question Number : 22 Question Id : 25498911261 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Gateway works at which of the layers of the OSI model?

Options :

1.  Physical layer

2.  Session layer

3.  Network layer

4.  Data link layer
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Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

OSI मॉडल के कौन-से ×तर (लेयर) पर गेटवे (Gateway) काम करता है?

Options :

1.  िफि_कल लेयर

2.  सेशन लेयर 

3.  नेटवकµ  लेयर 

4.  डेटा िलंक लेयर 

   

Question Number : 23 Question Id : 25498911272 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The major advantage of FM over AM is:



Options :

1.  higher geographical interference

2.  high radiated power

3.  more complicated receiver and transmitter

4.  improved signal to noise ratio
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: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

AM की तुलना मƶ FM का मु¸य लाभ ·या है?

Options :

1.  उ¼च भौगोिलक ह×त³ेप

2.  उ¼च िविकरण शिǣ

3.  अिधक जिटल िरसीवर और Ĉांसमीटर

4.  शोर अनुपात के िलए बेहतर संकेत

   

Question Number : 24 Question Id : 25498913470 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following features allow you to narrow down the data in your work sheet?

Options :

1.  Filters

2.  Merge Cells

3.  Fill Handle



4.  Format
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िनÏनिलिखत मƶ से कौन सी िवशेषताए ंआपको अपनी वकµ शीट मƶ डेटा को कम करने की अनुमित देती हƹ?

Options :

1.  िफÒटर 

2.  मजµ सेल

3.  िफल हƹडल

4.  फॉमƷट

   

Question Number : 25 Question Id : 25498913778 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ creates a unique, fixed-length signature for a message or data set.

Options :

1.  Popular key algorithm

2.  Secret key algorithm

3.  Public key algorithm

4.  Hashing
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Correct Marks : 1 Wrong Marks : 0

________ िकसी मैसेज या डेटा सेट के िलए एक अनूठा, िनिȆत लंबाई वाला ह×ता³र िþएट करता है।

Options :

1.  पॉपुलर की एÒगोिरथम

2.  सीþेट की एÒगोिरथम

3.  पिÍलक की एÒगोिरथम

4.  हिैशंग

   

Question Number : 26 Question Id : 25498918499 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The dot matrix printer belongs to which of the following categories of printers?

Options :

1.  Line

2.  Off band

3.  Non-impact

4.  Character
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Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0
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डॉट मैिĈ·स िĒटंर िनÏन मƶ से िकस Ēकार का िĒंटर है?

Options :

1.  लाइन

2. 



 ऑफ बƹड

3.  नॉन-इÏपै·ट

4.  कैर·ेटर

   

Question Number : 27 Question Id : 25498918527 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

There are operating systems that perform multitasking. Which of the following is NOT a 

multitasking enabled OS?

Options :

1.  Windows 10

2.  Windows XP

3.  Windows 7

4.  MS DOS 2.0
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कई ऑपरेिटंग िस×टम मÒटीटाि×कंग (एकािधक कायµ) करते हƹ। िनÏन मƶ से कौन सा मÒटीटाि×कंग ऑपरिेटंग िस×टम (OS) नहƭ है?

Options :

1.  Windows 10

2.  Windows XP

3.  Windows 7

4.  MS DOS 2.0



   

Question Number : 28 Question Id : 25498924004 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In Graphical User Interface ( GUI ) computer, the __________  is an image that represents an 

application, a capability, or some other concept or specific entity with meaning for the user.

Options :

1.  label

2.  icon

3.  graph

4.  file
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: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Āािफकल यूजर इंटरफेस (GUI) कंËयटूर मƶ, __________ एक इमेज है जो एक एिËलकेशन, एक ³मता, या कुछ अÊय अवधारणा या 
िविशȌ इकाई का ĒितिनिधÆव करती है जो उपयोगकताµ के िलए मायने रखती है।

Options :

1.  लेबल

2.  आइकन

3.  Āाफ

4.  फाइल

   

Question Number : 29 Question Id : 25498924033 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

The ______ is the bar that runs across the bottom of the Windows screen in a computer system.

Options :

1.  Title bar

2.  Taskbar

3.  Toolbar

4.  Menu bar
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Correct Marks : 1 Wrong Marks : 0

______ वह बार है जो कंËयटूर िस×टम मƶ Windows ×þीन के नीचे चलता है।

Options :

1.  टाइटल बार

2.  टा×कबार

3.  टूलबार

4.  मेनू बार
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A program which is input to the compiler is called a ______.

Options :

1.  Source program

2. 



 Object code

3.  Translator

4.  Enabler
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एक ĒोĀाम जो कंपाइलर के िलए इनपुट होता है, उसे ______ कहा जाता है।

Options :

1.  सोसµ ĒोĀाम

2.  ऑÍज·ेट कोड

3.  Ĉांसलेटर

4.  इनेबलर

   

Question Number : 31 Question Id : 2549896773 Question Type : MCQ Option Shuffling : Yes 
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Which of the following is NOT an email program?

Options :

1.  Microsoft Outlook Express

2.  Gmail

3.  eBay

4.  Thunderbird
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िनÏनिलिखत मƶ से कौन सा एक ईमेल ĒोĀाम नहƭ है?

Options :

1.  Microsoft Outlook Express

2.  Gmail

3.  eBay

4.  Thunderbird 
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गूगल कैलƶडर मƶ इवƶट िववरण देखने के िलए ______ की का उपयोग िकया जाता है।

Options :

1.  N

2.  S

3.  T

4.  E
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In Google calendar, ______ key is used to view an event's details.

Options :



1.  N

2.  S

3.  T

4.  E
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Which among the following is NOT a secondary storage device in a computer?

Options :

1.  RAM

2.  Hard Disk

3.  CD

4.  DVD
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िनÏनिलिखत मƶ से कौनसा कंËयटूर मƶ सकेƶ डरी ×टोरेज िडवाइस नहƭ है?

Options :

1.  RAM

2.  हाडµ िड×क

3.  CD

4.  DVD



   

Question Number : 34 Question Id : 2549898979 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0
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In MS-Word tables, the AutoFit button is used to:

Options :

1.  format each columns width to be as bold as the size of the text

2.  format each columns width to be only as wide as the text in the longest cell in the column

3.  cut the text and paste in a new location

4.  make large documents more readable
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MS-Word टेबल मƶ, AutoFit बटन का उपयोग िनÏन के िलए िकया जाता है:

Options :

1.  ĒÆयके कॉलम की चौ`ाई को टे·×ट के आकार िजतना बोÒड होने के िलए Ēाƞिपत करƶ

2.  कॉलम मƶ सबसे लंबे सेल मƶ टे·×ट के ƞप मƶ केवल उतना ही चौ`ा होने के िलए ĒÆयके कॉलम की चौ`ाई को Ēाƞिपत करƶ

3.  टे·×ट को कट करने और नए ×थान पर पे×ट करने

4.  ब`े डॉ·यूमƶट को और अिधक पठनीय बनाने
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When we apply any change case to an alphanumeric term, which of the following options will be 

true in MS-Word?

Options :

1.  It converts only the letters in the alphanumeric.

2.  It converts only the letters and deletes the numbers.

3.  No action will be performed.

4.  It always converts the text into small letters.
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जब हम अÒbाÊयमेूिरक शÍद मƶ कोई पिरवतµन मामला लागू करते हƹ, तो MS-Word मƶ िनÏनिलिखत मƶ से कौन सा िवकÒप सही होगा?

Options :

1.  यह केवल अ³रǂ को अÒbाÊयमेूिरक मƶ पिरवितंत करता है।

2.  यह केवल अ³रǂ को पिरवितंत करता है और सं̧ याǓ को हटा देता है।

3.  कोई कारµवाई नहƭ की जाएगी।

4.  यह हमेशा टे·×ट को छोटे अ³रǂ मƶ बदलता है।

   

Question Number : 36 Question Id : 25498910553 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 
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In MS-Word, if you choose 'Mirror margins' from the standard margin styles, then the labels, Left 

and Right margins change to ______.

Options :

1.  Top and Bottom



2.  Left and Right

3.  Inside and Outside

4.  Bottom and Top
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MS-Word मƶ, यिद आप मानक मािजंन शिैलयǂ से 'िमरर मािजंन' चुनते हƹ, तो लेबल, बाए ँऔर दाए ँमािजंन ______ मƶ बदल जाते हƹ।

Options :

1.  टॉप और बॉटम

2.  लÌेट और राइट

3.  इनसाइड और आउटसाइड

4.  बॉटम और टॉप

   

Question Number : 37 Question Id : 25498910577 Question Type : MCQ Option Shuffling : Yes 
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If Deepika wants to hide the ruler, then she has to choose 'View' and select the _______ check box in 

MS-Word.

Options :

1.  Ruler

2.  Grid lines

3.  Message bar

4.  Thumbnails
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यिद दीिपका ƞलर को छुपाना चाहती है, तो उसे 'ȅू' चुनना होगा और MS-Word मƶ _______ चेक बॉ·स का चयन करना होगा।

Options :

1.  ƞलर

2.  िĀड लाइनƶ

3.  संदेश बार

4.  थंबनेल

   

Question Number : 38 Question Id : 25498910600 Question Type : MCQ Option Shuffling : Yes 
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From the following options, identify the special types of indentation in MS-Word. 

a) First line 

b) Hanging 

c) Left indent 

d) Right indent

Options :

1.  a, b

2.  b, c

3.  b, d

4.  a, c
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िनÏनिलिखत िवकÒपǂ मƶ से MS-Word मƶ िवशेष Ēकार के इंडƶटेशन की पहचान करƶ। 
 

a) पहली लाइन 

b) हƹिगंग 

c) बायां इंडƶट 

d) दायां इंडƶट

Options :

1.  a, b

2.  b, c

3.  b, d

4.  a, c

   

Question Number : 39 Question Id : 25498910722 Question Type : MCQ Option Shuffling : Yes 
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Correct Marks : 1 Wrong Marks : 0

Which of the following option is invalid during document search in MS-Word?

Options :

1.  Match case

2.  No formatting

3.  Find whole words only

4.  Sounds like
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िनÏनिलिखत मƶ MS-Word मƶ द×तावे_ खोज के दौरान कौन सा िवकÒप अमाÊय है?

Options :

1.  मैच केस

2.  नो फोमƷिटंग

3.  फाइंड होल वड्µस ओनली

4.  साउंड लाइक

   

Question Number : 40 Question Id : 25498911504 Question Type : MCQ Option Shuffling : Yes 
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Following are the steps to turn off the Capitalize the first letter of sentences feature in MS-Word. 

Arrange the steps in the correct order. 

 

a) Make sure the AutoCorrect tab is displayed. 

b) Choose AutoCorrect Options from the Tools menu. Word displays the AutoCorrect dialog box. 

c) Click on OK. 

d) Clear the Capitalize First Letter of Sentences check box.

Options :

1.  b, a, d, c

2.  b, a, c, d

3.  b, d, a, c

4.  b, c, d, a
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MS-Word मƶ कैिपटलाइज द फ×टµ लेटर ऑफ सƶटƶस फीचर को बंद करने के चरण िनÏनिलिखत हƹ। चरणǂ को सही þम मƶ ȅवि×थत 
करƶ। 
 

a) सुिनिȆत करƶ िक ऑटोकरे·ट टैब िदख रहा है। 
b) टूÒस मेनू से ऑटोकर·ेट िवकÒप चुनƶ। Word ऑटोकरे·ट डायलॉग बॉ·स Ēदिशतं करता ह ै

c) OK पर ि·लक करƶ। 
d) 'Capitalize First Letter of Sentences' चेक बॉ·स को ि·लयर करƶ।

Options :

1.  b, a, d, c

2.  b, a, c, d

3.  b, d, a, c

4.  b, c, d, a

   

Question Number : 41 Question Id : 25498911881 Question Type : MCQ Option Shuffling : Yes 
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In MS-Word, ______ feature has to be selected under the Balloons command to show deletions as 

crossed out and comments inline.

Options :

1.  All Revisions Inline

2.  Show All Revisions Inline

3.  Show Revisions in balloons

4.  Show only comments and formatting in balloons
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MS-Word मƶ, हटाए गए को þॉस आउट और िटËपिणयǂ को इनलाइन िदखाने के िलए बलूÊस कमांड के तहत ______ सिुवधा का 
चयन कीिजये।

Options :

1.  सभी िरवी_न इनलाइन

2.  सभी िरवी_न इनलाइन िदखाए ं

3.  िरवी_नǂ को बैलूÊस मƶ िदखाए ं

4.  बैलूÊस मƶ केवल कमƶट्स और फॉमƷिटंग िदखाए ं
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Which of the following is a character encoding standard?

Options :

1.  ASCII

2.  ISO

3.  HTM

4.  XML
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िनÏनिलिखत मƶ से कौन सा एक वणµ एÊकोिडंग मानक है?

Options :

1.  ASCII

2.  ISO

3.  HTM

4.  XML
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What happens to the screen when we open a header section in MS-Word?

Options :

1.  Document area appears shaded; header marker and dashed line show up.

2.  Screen will remain unchanged.

3.  Header area brightens up.

4.  Footer section collapses
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जब हम MS-Word मƶ हेडर से·शन खोलते हƹ तो ×þीन का ·या होता है?

Options :

1.  डॉ·यूमƶट एिरया धुंधला िदखाई देता है, हेडर माकµ र और डैश लाइन उभरकर िदखाई देती हƹ।

2.  ×þीन अपिरवितंत रहेगी।



3.  हेडर एिरया चमकदार हो जाता है।

4.  फुटर से·शन गायब हो जाता है।
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In MS-Word, to start from ready to use mail merge template that can be customised according to 

the needs, __________ radio button has to be enabled under the Select starting document step. 

Options :

1.  Use the current document

2.  Start from a template

3.  Start from existing template

4.  Start using current document
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MS-Word मƶ, रेडी टू यूज मेल मजµ टेÏËलेट से शƞु करने के िलए िजसे जƞरतǂ के अनुसार अनुकूिलत िकया जा सकता है, 
__________ रेिडयो बटन को सेल·ेट ×टािटंग डॉ·यमूƶट ×टेप के तहत स³म करना होगा।

Options :

1.  वतµमान डॉ·यूमƶट का इ×तेमाल करƶ

2.  िकसी टेÏपलेट से शƞु करƶ

3.  मौजूदा टेÏपलेट से शƞु करƶ

4.  वतµमान डॉ·यूमƶट के उपयोग से शुƞ करƶ
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WWW uses ______ protocol.

Options :

1.  FTP

2.  HTTP

3.  WBC

4.  MTP

   

Question Number : 45 Question Id : 25498920453 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

WWW ______ Ēोटोकॉल का उपयोग करता है।

Options :

1.  FTP

2.  HTTP

3.  WBC

4.  MTP
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_______ मƶ, वेब पर कोई उपयोगकताµ लॉग इन करने वाले िकसी अÊय उपयोगकताµ से संपकµ  कर सकता है और बातचीत जारी रख 
सकता है।

Options :

1.  हाइपर टिमंनल सिवंस

2.  नेट कने·ट सिवंस

3.  इं×टƶट सिवसं

4.  इं×टƶट मैसेिजगं
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In _______, a user on the Web can contact another user who is logged in and continue with the 

conversation.

Options :

1.  hyper terminal services

2.  net connect services

3.  instant services

4.  instant messaging
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Which of the following is NOT the Section Break Option in MS-Word?

Options :

1.  Previous Page



2.  Next Page

3.  Odd Page

4.  Even Page
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िनÏनिलिखत मƶ से कौन सा MS-Word मƶ से·शन Ĕेक िवकÒप नहƭ है?

Options :

1.  Ēीिवयस पेज

2.  ने·×ट पेज

3.  ऑड पेज

4.  इवन पेज
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In MS-Word, the page orientation will NOT affect font style, font colour, and ______.

Options :

1.  page spacing

2.  height and width

3.  font size

4.  number of lines in a page
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MS-Word मƶ पेज ओिरएटेंशन bॉÊट के ×टाइल, bॉÊट के कलर और ______ को Ēभािवत नहƭ करेगा।

Options :

1.  पेज ×पिेसंग

2.  ऊंचाई तथा चौ`ाई

3.   bॉÊट के आकार

4.  पेज मƶ लाइनǂ की सं¸या
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How will you save the existing document file in another folder in MS-Word?

Options :

1.  File->Save

2.  Ctrl + S ->Select Folder

3.  File->Save As

4.  Insert ->Save As
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आप MS-Word मƶ मौजूदा द×तावे_ bाइल को Ơसरे bोÒडर मƶ कैसे सहेजƶगे?



Options :

1.  File->Save

2.  Ctrl + S ->Select Folder

3.  File->Save As

4.  Insert ->Save As
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Which of the following font effects places text below other characters on the same line in MS-

Word?

Options :

1.  Subscript

2.  Strikethrough

3.  Emboss

4.  Superscript
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िनÏनिलिखत मƶ से कौन सा फॉÊट Ēभाव MS-Word मƶ टे·×ट को अÊय वणǄ के नीचे एक ही पिंǣ मƶ रखता है?

Options :

1.  सबि×þËट

2.  ×ĈाइकĎू

3. 



 एमबॉस

4.  सुपरि×þËट
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In MS-Word, some dialog boxes have multiple tabs. You can switch between these tabs by 

pressing the ______ keys together.

Options :

1.  Ctrl + Z

2.  Ctrl + Tab

3.  Alt + Tab

4.  Alt + N
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एमएस-वडµ मƶ, कुछ डायलॉग बॉ·स मƶ कई टैब होते हƹ। आप ______ कंुिजयǂ को एक साथ दबाकर इन टैब के बीच ि×वच कर सकते हƹ।

Options :

1.  Ctrl + Z

2.  Ctrl + Tab

3.  Alt + Tab

4.  Alt + N
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While working with MS-Word, ______ option is not available in the file menu.

Options :

1.  Print

2.  Header & Footer

3.  Save As

4.  Save
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MS-Word के साथ कायµ करते समय, फाइल मेÊय ूमƶ ______ िवकÒप उपलÍध नहƭ होता है।

Options :

1.  िĒंट

2.  हैडर और फुटर

3.  सेव ऐज

4.  सेव
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None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Question Numbers : (53 to 57)

Read the given passage and answer the questions. 

 

My brother was five years elder to me but only three grades ahead. He’d begun his studies at the 

same age as I had, but he didn’t like the idea of moving hastily in an important matter like 

education. He wanted to lay a firm foundation so he took two years to do one year’s work. I was 

nine, he was fourteen. He had full right to supervise and instruct me. And I was expected to accept 

every order of his as law. 

 

By nature he was studious. He was always sitting with a book open. And perhaps to rest his brain, 

he would sometimes draw pictures of birds and cats in the margin of his notebook. Occasionally, 

he would write a name, a word or a sentence ten or twenty times. He might even create new 

words which made no rhyme or reason. To understand his creation was beyond my powers. 

 

I wasn’t very keen about studies. To sit with a book for an hour was a tremendous effort. As soon 

as I found a chance I’d leave the hostel and play marbles or fly paper kites or sometimes just meet 

a friend. Sometimes we would climb on to the courtyard walls and jump down. But as soon as I 



came back into the room and saw my brother’s scowling face I lost all my power to think. His first 

question would be, “Where were you?” My silence was an acknowledgement of guilt and my 

brother’s only remedy was to greet me with indignant words. 

 

“If you study English this way you’ll be studying your whole life! Studying English is no laughing 

matter, that anyone who wants to, can learn. Haven’t you seen how much I grind? Everyday there 

are cricket and hockey matches but I don’t go near them. I keep on studying all the time and even 

then it takes me two-three years for one grade. So how do you expect to pass? It would be better 

that you went home and played gilli-danda to your heart’s content. Why waste our father’s hard 

earned money?”

Sub questions
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The author had to follow every order by his brother mainly because the brother:

Options :

1.  was wiser than him

2.  was senior to him in age

3.  was more knowledgeable

4.  had a firm foundation
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Which of the following shows that the author’s brother was actually NOT studious?

Options :

1.  He always sat with a book open.



2.  He never went to watch a match.

3.  He took two years to pass a class.

4.  He didn’t go out to play.
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How do we know that the author was good at his studies?

Options :

1.  There was less gap between the author and his brother’s grades than their ages.

2.  Both, the author and his brother had started studies at the same age.

3.  The author found it hard to sit with a book.

4.  The author loved to play marbles and fly kites.
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When the author returned from playing, his brother would do all of the following, EXCEPT:

Options :

1.  make him feel guilty

2.  scold him

3.  scowl at him

4.  make him happy
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The author would feel guilty because:

Options :

1.  he went to play instead of studying

2.  he scored better marks than his brother

3.  he had not studied English

4.  he was wasting his father’s money
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िदए गए गȁांश को पaƶ  और उसके आधार पर Ēȋǂ के उǶर दƶ। 
 

मेरे भाई साहब मुझसे पʶच साल ब`े थे, लेिकन तीन दरजे आगे। उÊहोने भी उसी उĖ मƶ पढना शƞु िकया था जब मैने शुƞ िकया; लेिकन 
तालीम जैसे महÆव के मामले मƶ वह जÒदीबाजी से काम लेना पसंद न करते थे। इस भवन िक बुिनयाद खूब मजबूत डालना चाहते थे। 
इसिलए एक साल का काम दो साल मƶ करते थे।मƹ छोटा था, वह ब`े थे। मेरी उĖ नौ साल िक,वह चौदह साल के थे। उÊहƶ मेरी तÏबीह 
और िनगरानी का पूरा जÊमिसǽ अिधकार था। और मेरी शालीनता इसी मƶ थी िक उनके Ɠ·म को कानून समझूँ। 
वह ×वभाव से ब`े अºययनशील थे। हरदम िकताब खोले बैठे रहते और शायद िदमाग को आराम देने के िलए कभी कापी पर, कभी 
िकताब के हािशयǂ पर िचिडयǂ, कुÆतǂ, बिÒलयो की त×वीरƶ बनाया करते थƶ। कभी-कभी एक ही नाम या शÍद या वा·य दस-बीस बार 
िलख डालते। कभी एक शेर को बार-बार सÊुदर अ³र से नकल करते। कभी ऐसी शÍद-रचना करते, िजसमƶ न कोई अथµ होता, न कोई 
सामंज×य! उनकी इन रचनाǓ को समझना मेरी समझ से परे था। 
मेरा पaाई मƶ ¾यादा मन नहƭ लगता था। एक घंटा भी िकताब लेकर बैठना पहा` था। मौका पाते ही हॉ×टल से िनकलकर मैदान मƶ आ 
जाता और कभी कंकिरयां उछालता, कभी कागज िक िततिलयाँ उ`ाता, और कहƭ कोई साथी िमल गया तो पूछना ही ·या कभी 
चारदीवारी पर चढकर नीचे कूद रहे है, कभी फाटक पर वार, उसे आगे-पीछे चलाते Ɠए मोटरकार का आनंद उठा रहे है। लेिकन कमरे मƶ 
आते ही भाई साहब का रौď ƞप देखकर Ēाण सूख जाते। उनका पहला सवाल होता-'कहां थƶ?' हमेशा यही सवाल, इसी ºविन मƶ पूछा 
जाता था और इसका जवाब मेरे पास केवल मौन था। 
‘इस तरह अĀेंजी पaोगे, तो िजÊदगी-भर पaते रहोगे और एक हफµ  न आएगा। अĀेंजी पaना कोई हंसी-खेल नही है, िक जो चाहे, पa ले। 
तुम िकतने घǂघा हो िक मुझे देखकर भी सबक नही लेते, मƹ िकतनी मेहनत करता Ɣं। मƹ हमेशा पaता रहता Ɣ,ं उस पर भी एक-एक दरजे 



मƶ दो-दो, तीन-तीन साल प`ा रहता Ɣं िफर तुम कैसे आशा करते हो िक तुम यǂ खेल-कुद मƶ व·त गंवाकर पास हो जाओगे? अगर तुÏहे 
इस तरह उĖ गंवानी है, तो बेहतर है, घर चले जाओ और मजे से गुÒली-डंडा खेलो। िपता की गाaी कमाई के ƞपये ·यǂ बरबाद करते 
हो?’

Sub questions
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लेखक अपने भाई की हर बात ·यǂ मानता है?

Options :

1.  ·यǂिक वे उससे अिधक समझदार थे

2.  ·यǂिक वे उĖ मƶ उससे ब`े थे

3.  ·यǂिक वे उससे अिधक बुिǽमान थे

4.  ·यǂिक उनकी जानकारी बƓत गूa थी
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िनÏन मƶ से कौन सी बात यह दशाµती है िक लेखक के भाई वा×तव मƶ अÉययनशील नहƭ थे?

Options :

1.  वह हमेशा प×ुतक खोलकर बैठे रहते थे

2.  वह कभी भी मैच देखने नहƭ जाते थे

3.  एक ही क³ा मƶ उǶीणµ होने के िलए उÊहƶ दो वषµ लगते

4.  वह बाहर खेलने नहƭ जाते थे

 

Question Number : 55 Question Id : 25498921208 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

हमƶ यह कैसे पता चलता है िक लेखक की पaाई मƶ ƞिच थी?

Options :

1.  उसके भाई की तुलना मƶ लेखक की उĖ और क³ा मƶ कम अंतर था

2.  लेखक और उसके भाई, दोनǂ ने पaाई की शƝुआत एक ही उĖ मƶ की थी

3.  लेखक को प×ुतक के साथ बैठे रहना बƓत किठन Ēतीत होता था

4.  लेखक को कंचे खेलना और पतंग उ`ाना बƓत पसंद था

 

Question Number : 56 Question Id : 25498921209 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जब लेखक खेलकर वापस आता, तो उसका भाई िनÏन मƶ से िकसके अितिरǣ उसे और सब कहता था?

Options :

1.  उसे दोषी महसूस कराता

2.  उसे डांटता

3.  उस पर गु×सा करता

4.  उसको खुश करने की कोिशश करता

 

Question Number : 57 Question Id : 25498921210 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

लेखक ×वयं को दोषी ·यǂ महसूस करता था?

Options :



1.  वह पaाई करने के बजाय खेलने जाता था

2.  उसने अपने भाई से बेहतर अंक ĒाËत िकए

3.  उसने अĀें_ी के पाठ की पaाई नहƭ की थी

4.  वह अपने िपता की मेहनत की कमाई को बबाµद कर रहा था

   

   

QUANTITATIVE APTITUDE
Section Id : 2549897136

Section Number : 3

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 6

Number of Questions to be attempted : 6

Section Marks : 6

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897177

Question Shuffling Allowed : Yes

Is Section Default? : null

   

Question Number : 58 Question Id : 25498928826 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



Options :

1.  3

2.  4

3.  5

4.  6

   

Question Number : 58 Question Id : 25498928826 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 59 Question Id : 25498928892 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 59 Question Id : 25498928892 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 



   

Question Number : 60 Question Id : 25498929050 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What will come in place of the question mark (?) in the given number series? 

190, 94, 46, 22, ?, 4

Options :

1.  19

2.  15

3.  10

4.  8

   

Question Number : 60 Question Id : 25498929050 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   



 

   

Question Number : 61 Question Id : 25498929099 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  0.5

2.  10

3.  37

4.  45

   

Question Number : 61 Question Id : 25498929099 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  0.5

2.  10

3.  37

4.  45

   

Question Number : 62 Question Id : 25498929379 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  570

2.  760

3.  800

4.  950

   

Question Number : 62 Question Id : 25498929379 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 63 Question Id : 25498929664 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 



: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

As observed from the top of a lighthouse, 120 m above sea level, the angle of depression of a ship, 

sailing directly towards is, changes from 30° to 45°. The distance (in m) travelled by the ship during 

the period of observation is nearest to:

Options :

1.  86.7

2.  86.9

3.  87.8

4.  88.9

   

Question Number : 63 Question Id : 25498929664 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  86.7

2.  86.9

3.  87.8

4.  88.9

   

   

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549897137



Section Number : 4

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 6

Number of Questions to be attempted : 6

Section Marks : 6

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897178

Question Shuffling Allowed : Yes

Is Section Default? : null

   

Question Number : 64 Question Id : 25498914081 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Unscramble the letters in the words given in options, and find the odd one out.

Options :

1.  HARCI

2.  EANOGR

3.  ABNNAA

4.  EALPP

   

Question Number : 64 Question Id : 25498914081 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

िवकÒपǂ मƶ िदए गए अȅवि×थत अ³रǂ को ȅवि×थत कर साथµक शÍदǂ का िनमाµण करƶ और उनमƶ से असंगत शÍद का चयन करƶ।

Options :

1.  HARCI

2.  EANOGR

3.  ABNNAA

4.  EALPP

   

Question Number : 65 Question Id : 25498918994 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Select the pair from among the options that will fill in the two blanks, respectively, to form a true 

and sensible sentence. 

 

______ is to second as day is to _______.

Options :

1.  Watch – Friday

2.  Minute – Hour

3.  First – Hour

4.  First – Light

   

Question Number : 65 Question Id : 25498918994 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏनिलिखत वा·य को सही Ēाƞप मƶ लाने के िलए इसके िरǣ ×थानǂ पर þिमक ƞप से आने वाले अ³रǂ वाले िवकÒप का चयन 
कीिजए। 



 

______ का सेकंड से वही संबंध है, जो संबंध िदन  का _____ से है।

Options :

1.  घ`ी – शुþवार

2.  िमनट – घंटा

3.  Ēथम – घंटा

4.  Ēथम – Ēकाश

   

Question Number : 66 Question Id : 25498919674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Select the option that is related to the third number in the same way as the second number is 

related to the first number. 

 

335 : 216 : : 987 : ?

Options :

1.  867

2.  868

3.  872

4.  888

   

Question Number : 66 Question Id : 25498919674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

उस िवकÒप का चयन कीिजए जो तीसरी सं̧ या से उसी Ēकार संबंिधत है िजस Ēकार Ơसरी सं¸या पहली सं¸या से संबंिधत है।  
 



335 : 216 :: 987 : ?

Options :

1.  867

2.  868

3.  872

4.  888

   

Question Number : 67 Question Id : 25498919723 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Between the two book-ends in your study are displayed your five favourite puzzle books. If you 

decide to arrange the five books in every possible combination and moved just one book every 

minute, then how long would it take you?

Options :

1.  1 hour

2.  2 hour

3.  3 hour

4.  4 hour

   

Question Number : 67 Question Id : 25498919723 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

आपके अÉययन क³ मƶ दो पु×तक के बीच आपकी पांच पसंदीदा पहेली की िकताबƶ Ēदिशंत की जाती हƹ। यिद आप हर संभािवत 
संयोजन मƶ इन पांच प×ुतकǂ की पुनȅµवि×थत करने का िनणµय लेते हƹ और ĒÆयके िमनट मƶ केवल एक प×ुतक को उठाते हƹ, तो ऐसा 
करने मƶ आपको कुल िकतना समय लगेगा?

Options :



1.  1 घंटा

2.  2 घंटे

3.  3 घंटे

4.  4 घंटे

   

Question Number : 68 Question Id : 25498919818 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Four words have been given, out of which three are alike in some manner and one is different. 

Select the one that is different.

Options :

1.  Lima

2.  Algiers

3.  New York

4.  Tokyo

   

Question Number : 68 Question Id : 25498919818 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िवकÒपǂ मƶ चार शÍद िदए गए हƹ िजनमƶ से तीन िकसी तरह समान हƹ और उनमƶ से कोई एक असंगत है। उस असंगत शÍद का चयन करƶ।

Options :

1.  लीमा

2.  अÒजीयसµ

3.  Êययूॉकµ



4.  टो·यो

   

Question Number : 69 Question Id : 25498927388 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   



 

4.   

 

   

Question Number : 69 Question Id : 25498927388 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3. 



  

 

4.   
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Section Id : 2549897138

Section Number : 5

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 6

Number of Questions to be attempted : 6

Section Marks : 6

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897179

Question Shuffling Allowed : Yes

Is Section Default? : null

   



Question Number : 70 Question Id : 2549899686 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The Ninth Five-Year Plan in India covered the period of:

Options :

1.  1990-1995

2.  1992-1997

3.  1997-2002

4.  1999-2003

   

Question Number : 70 Question Id : 2549899686 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

भारत मƶ नǅवƭ पंचवषƮय योजना की अविध ·या थी?

Options :

1.  1990-1995

2.  1992-1997

3.  1997-2002

4.  1999-2003

   

Question Number : 71 Question Id : 25498912534 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The breeding, rearing and transplantation of fish by artificial means is called ________________.

Options :



1.  aquaculture

2.  horticulture

3.  pisciculture

4.  viticulture

   

Question Number : 71 Question Id : 25498912534 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कृिčम तरीकǂ Ǽारा मछिलयǂ का Ēजनन, पालन और Ēितरोपण ·या कहलाता है?

Options :

1.  ए·वाकÒचर

2.  हॉिटंकÒचर

3.  िपसीकÒचर

4.  िवटीकÒचर

   

Question Number : 72 Question Id : 25498912784 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Geoff Boycott's name is associated with which of the following games?

Options :

1.  Boxing

2.  Cricket

3.  Golf

4.  Swimming



   

Question Number : 72 Question Id : 25498912784 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

¾योēी बॉयकॉट का नाम िनÏन मƶ से िकस खेल से जु̀ ा Ɠआ है?

Options :

1.  मु·केबाजी

2.  िþकेट

3.  गोÒb

4.  तैराकी

   

Question Number : 73 Question Id : 25498929956 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Match the columns. 

 

Landforms Processes 

A. Kick point 1. Karst 

B. Sink hole 2. Fluvial 

C. Point bar 3. Plantation 

D. Accordant summit 4. Rejuvenation 

 

Options :

1.  A-3, B-2, C-1, D-4

2.  A-4, B-1, C-2, D-3

3.  A-3, B-1, C-2, D-4



4.  A-4, B-2, C-1, D-3

   

Question Number : 73 Question Id : 25498929956 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनÏन को सुमेिलत कीिजए:  
 

×थलाकृितयां Ēिþयाए ं

A. िकक पॉइंट 1. का×टµ 
B. िसंक होल 2. Ìलिूवयल 

C. पॉइंट बार 3. पौधरोपण 

D. एकॉडƸट सिमट 4. पुनजƮवन  
 

Options :

1.  A-3, B-2, C-1, D-4

2.  A-4, B-1, C-2, D-3

3.  A-3, B-1, C-2, D-4

4.  A-4, B-2, C-1, D-3

   

Question Number : 74 Question Id : 25498932558 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

How many times has financial emergency been declared in India till August 2021? 

Options :

1.  Once

2.  Four times



3.  Five times

4.  Never

   

Question Number : 74 Question Id : 25498932558 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

अग×त 2021 तक, भारत मƶ िवǶीय आपातकाल िकतनी बार घोिषत िकया गया है? 

Options :

1.  एक बार

2.  चार बार

3.  पांच बार

4.  एकबार भी नहƭ

   

Question Number : 75 Question Id : 25498935396 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Hydrolysis of cane sugar is called:

Options :

1.  saponification

2.  hydration

3.  inversion

4.  esterification

   

Question Number : 75 Question Id : 25498935396 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

गȃे से ĒाËत होने वाली चीनी के जलीय अपघटन को ·या कहा जाता है? 

Options :

1.  साबुनीकरण

2.  जलयोजन

3.  उÆþमण

4.  ए×टरीकरण

   

   

English Mock
Group Number : 2
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Group Maximum Duration : 5
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Show Attended Group? : No

Edit Attended Group? : No

Break time : 1

Mandatory Break time : Yes

Group Marks : 0

Is this Group for Examiner? : No

Examiner permission : Cant View

Show Progress Bar? : No

   

   

English Mock
Section Id : 2549897139



Section Number : 1
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Number of Questions : 1
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Clear Response :
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Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897180

Question Shuffling Allowed : No

Is Section Default? : Yes

   

Question Number : 76 Question Id : 25498940961 Question Type : TYPING TEST Display 

Question Number : Yes Calculator : None

Summer camps are supervised camps conducted to entertain as well as equip students with 

various life skills such as teamwork, socializing, decision making, independent and 

responsible living and more. It aids the overall development of a child and children have fun 

during this process as they get to explore new arenas.

Restricted/ Unrestricted : Unrestricted

Paragraph Display : Yes

Keyboard Layout : Inscript

Show Details Panel : Yes

Show Error Count : Yes

Highlight Correct or Incorrect Words : Yes

Allow Back Space : Yes

Show Back Space Count : Yes

   

   



English Actual
Group Number : 3

Group Id : 2549894530

Group Maximum Duration : 15

Group Minimum Duration : 15

Show Attended Group? : No

Edit Attended Group? : No

Break time : 3

Mandatory Break time : Yes

Group Marks : 0

Is this Group for Examiner? : No

Examiner permission : Cant View

Show Progress Bar? : No

   

   

English Typing Test
Section Id : 2549897140

Section Number : 1

Section type : Typing Test

Mandatory or Optional : Mandatory

Number of Questions : 1

Number of Questions to be attempted : 1

Section Marks : 0

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897181

Question Shuffling Allowed : No



Is Section Default? : Yes

   

Question Number : 77 Question Id : 25498938659 Question Type : TYPING TEST Display 

Question Number : Yes Calculator : None

Domestic and international communication has expanded across the globe. This is the 

reason why there is a need for a global language like English which has become the lingua 

franca in major parts of the world. English is one of the most dominating languages in the 

world. It has an impact on every field of work. Although with the positive outcomes the 

negatives outweigh them to some degree as it means that many languages will perish out 

as a result. A global language is one that is spoken and understood at an international level 

by a wide variety of people. A global language is learned by several people as a second 

language. English is known to be the global language in that context. There are arguments 

that languages have a strong link between dominance and cultural power. The main factor 

that the languages exist is because of a powerful power base. The English language itself 

was derived from languages such as German and Latin and other European languages. 

Linguists argue whether the simplicity of the English language is the main reason for it 

becoming a global language. Generally difficulty level varies for everyone and there are 

different factors involved when a person starts learning a language. While learning another 

language one can observe that some languages are more difficult than others. Some 

languages have many similarities in pronunciation and words. For example Greek has 

similarities with Italian. Then there are languages having rough pronunciation or spelling 

and are dissimilar to any other language such as German. English is a very effective 

language and that is proved by the many native and foreign speakers worldwide. Statistics 

show nearly a quarter of the world is already fluent or content in English. Though the 

number of native Mandarin speakers is greater it is still not a global language because of its 

complicated letter system and grammar. Thus for a language to become a global language it 

has little to do with the number of native speakers. English helps to express various 

meanings. It has a lot of words with different meanings and different types of syntax which 

help the speaker to express with great accuracy. Another factor that makes English efficient 

is its compact letter system. It is unlike Mandarin with a ten thousand letter writing system 

which proves to be very difficult for people. Moreover the English language is very phonetic 

rather than character based. Hence it can help to describe the actual sounds of words or 

phrases. A poor feature of the English language is that there could be words with similar 

sounds but with different meaning. This can confuse non native speakers. Another difficulty 



in English is different regions of native English speakers have their accents which makes an 

outsider or a beginner learner of the language to not understand them clearly. Foreign 

speakers also have their specific accents. Since English is so widely spoken in the world 

many have taken up English as their second language. English has allowed a common 

communication means between people of different backgrounds. Hence English has helped 

to diminish certain cultural barriers between nations. However there are still cultural 

differences between countries and nations. In India which has thousands of local languages 

English is used as the official language as a smooth communication mean.
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एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उÊहƶ एक िहरण िदखा। जÒदबाजी मƶ तीर िनकालते 
Ɠए अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर बƓत ददµ मƶ था और गु×से मƶ भी।
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लीडरिशप एक अनूठा गुण है जो हर िकसी के पास नहƭ हो सकता। यिद आपके पास यह है तो आप खुद को खुशनसीब मान सकते हƹ। 
सही िदशा मƶ अपने किरयर को बढाने और अपने आस पास के लोगǂ को Ēरेणा देने के िलए लीडरिशप के गुण को आगे बढाना जƝरी है। 
हालांिक आगे बढने और अपने कौशल को सुधारने से पहले कई Ēकार के लीडरिशप शिैलयǂ को समझना जƞरी है। लोकतांिčक 
लीडरिशप आपके अधीन काम करने वाले लीडरिशप मƶ िनणµय लेने की Ēिþया का एक भाग हƹ। इस तरह का लीडरिशप अधीनǂ के 
योगदान पर कƶ िďत होता है। हालांिक उनके िनणµयǂ और कायµ की अंितम जवाबदेही नेता की है। यह सबसे पसदंीदा लीडरिशप शैिलयǂ मƶ 
से एक माना जाता है। पिरवतµनकारी लीडरिशप आपके समूह के सभासदǂ और संगठन के साथ ही Ơसरे कारकǂ मƶ सुधार करके Ēदशµन 
को Ēभािवत करने के बारे मƶ है। एक पिरवतµनकारी नेता शीषµ Ēयोजनǂ को कायम करके और उवµरता बढाने के िलए Ēिेषत करके सभी 
को Ēेिरत करता है। एक टीम का नेता अपनी पिरयोजना मƶ पूरी टीम को शािमल करता है। नेता अपनी टीम को कडी मेहनत करने के 
िलए Ēेिरत करता है और साथ ही वह िनधाµिरत Ēयोजनǂ को हािसल करने और पेशेवर ´ान के िवकास के िलए काम करता है। सामिरक 
लीडरिशप इस Ēकार की लीडरिशप शैली मƶ ऐसा नेता होता है जो मूल ƞप से एक फमµ या कंपनी का Ēमुख होता है लेिकन वह शीषµ 
Ēबंधन के िवचारǂ को साझा नहƭ करता है। वह पूरी टीम के साथ शािमल होता है। वह नई संभावनाǓ और यथाथµवाद की जƝरत के 
बीच की खाई को जोडने के िलए एक पुल की तरह कायµ करता है। ƠरदशƮ लीडरिशप का नेता अपनी टीम के सभासदǂ की Ēितभा और 
जƞरतǂ को पहचानता है। वह सफलता की नजर को कायम कर अिभĒते पिरणाम हािसल करने के िलए सामूिहक Ēयास करता है 
िजससे सभी सभासद आपस मƶ जुडे रहƶ। अगर टीम कम काम कर रही है तो एक सुगम नेता अपनी टीम के सभासदǂ को समय समय पर 
आदेश देकर उनकी काम करने की Ēिþया को कुशलतापवूµक चलाने मƶ मदद करता है। यिद टीम शीषµ कायµशील से पिरपूणµ है तो नेता 
काम करने के नजिरये को भी अपना सकता है। लीडरिशप की एक शैली मƶ टीम के सभासदǂ को अिधकार िदए जाते हƹ। टीम के सभी 
सभासदǂ को काम करने की छूट िमली होती है और नेता की ओर से कभी कभार आंिशक दखल अंदाजी होती रहती है। लेन देन संबंधी 
लीडरिशप इस Ēकार की लीडरिशप की Ēिþया मƶ लेन देन संबंधी कायµ शािमल है। इस Ēिþया के अंतगµत टीम के सभासदǂ को सही ढंग 
से नेता के िवचारǂ और िनणµय को लागू करने के िलए संमािनत िकया जाता है और इनाम भी िदया जाता है। साथ ही सभी को समय दर 
समय Ēिेरत भी िकया जाता है। सांकेितक लीडरिशप इस Ēकार के लीडरिशप शैली मƶ नेता अपने अनुयािययǂ के भरोसे के मूल को 
परखने और आचरण को बदलने के िलए समय लेता है तािक अपने कमµचािरयǂ से और बेहतर काम करवाया जा सके। अगर आपको 
ऐसा लगता है की लीडरिशप के गुण को अिधक Ēकारǂ मƶ नहƭ बांटा जा सकता तो यहां दी गई जानकारी यह िमथक तोडने मƶ मदद कर 
सकती है। इससे आप अपने अंदर मौजूद लीडरिशप के गुणǂ और बेजोड लीडरिशप शैली को पहचान कर उन पर महारथ हािसल कर 
सकते हƹ।
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